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Preface

Oracle's Agile PLM documentation set includes Adobe® Acrobat PDF files. The Oracle Technology
Network (OTN) Web site http://www.oracle.com/technetwork/documentation/agile-085940.html
contains the latest versions of the Agile PLM PDF files. You can view or download these manuals
from the Web site, or you can ask your Agile administrator if there is an Agile PLM Documentation
folder available on your network from which you can access the Agile PLM documentation (PDF)
files.

Note  To read the PDF files, you must use the free Adobe Acrobat Reader version 9.0 or later.
This program can be downloaded from the Adobe Web site http://www.adobe.com.

The Oracle Technology Network (OTN) Web site
http://www.oracle.com/technetwork/documentation/agile-085940.html can be accessed through Help
> Manuals in both Agile Web Client and Agile Java Client. If you need additional assistance or
information, please contact My Oracle Support (https://support.oracle.com) for assistance.

Note  Before calling Oracle Support about a problem with an Agile PLM manual, please have
the full part number, which is located on the title page.

TTY Access to Oracle Support Services

Oracle provides dedicated Text Telephone (TTY) access to Oracle Support Services within the
United States of America 24 hours a day, 7 days a week. For TTY support, call 800.446.2398.
Outside the United States, call +1.407.458.2479.

Readme
Any last-minute information about Agile PLM can be found in the Readme file on the Oracle

Technology Network (OTN) Web site http://www.oracle.com/technetwork/documentation/agile-
085940.html.

Agile Training Aids

Go to the Oracle University Web page
http://www.oracle.com/education/chooser/selectcountry _new.html for more information on Agile
Training offerings.

Accessibility of Code Examples in Documentation

Screen readers may not always correctly read the code examples in this document. The
conventions for writing code require that closing braces should appear on an otherwise empty line;
however, some screen readers may not always read a line of text that consists solely of a bracket or
brace.

This documentation may contain links to Web sites of other companies or organizations that Oracle
does not own or control. Oracle neither evaluates nor makes any representations regarding the
accessibility of these Web sites.
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Chapter 1

Overview of Agile PLM Data Mart
Installation

This chapter includes the following:

= Downloading Agile PLM Data Mart SOftWare..........cccciiuiiieiicisice et 1

This guide provides instructions and guidelines to successfully install or upgrade Agile PLM Data
Mart 3.2.0.2. You should be familiar with or have a working knowledge of Agile PLM and Oracle
Data Integrator to work with Agile PLM Data Mart.

This chapter provides the information required to access the necessary software.

Downloading Agile PLM Data Mart Software

This section provides information on downloading Agile PLM Data mart software from the Oracle
distribution locations.

Obtaining Software

Oracle products are distributed as "Product Packs". A Product Pack is an electronic version of the
software. Refer to the Media Pack description or the list of products that you purchased on your
Oracle ordering document. Then, view the Quick Install Guide License List to help you decide which
Product Pack you need. Prior to downloading, verify that the product you are looking for is in the
License and Options section of the Product Pack Readme. Oracle recommends that you print the
Readme for reference.

There will be an itemized part list within each of the packs and you will need to download all items in
order to have the complete download for the desired Oracle Agile release.

All Oracle Software Delivery Cloud files have been archived using Info-ZIP's highly portable Zip
utility. After downloading one or more of the archives, you will need the UnZip utility or the Winzip
utility to extract the files. You must unzip the archive on the platform for which it was intended.
Verify that the file size of your downloaded file matches the file size displayed on Oracle Software
Delivery Cloud. Unzip each Zip file to its own temporary directory.

To download the Oracle Product Lifecycle Analytics Software from Oracle Software Delivery
Cloud (http://edelivery.oracle.com):

1. On the Oracle Software Delivery Cloud Welcome page, click Sign In / Register.

2. Read the Terms & Restrictions. If you agree with the License Terms and Export Restrictions,
select the check boxes and click Continue.

3. Onthe Media Pack Search screen, select Oracle Agile Applications in the Select a Product Pack
drop-down list box. Select a Platform value. Click Go to view the applicable Agile release
downloads.

v3.2.0.2 1
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Select the appropriate link. Click Continue.

The Download page displays downloadable release parts, including customer guides. Click
Download for the appropriate media pack.

6. Extract the contents of the media pack, unzip the contents, and navigate to the product folder.
The installers for all platforms are available within the product folder, regardless of the
operating system on which you have chosen to install the software.

2 Agile Product Lifecycle Management



Chapter 2
Agile PLM Data Mart Overview

This chapter includes the following:

B INETOAUCTION ... 3

= Agile PLM Data Mart FEATUIES ........ceviiiiriricircserciscisce st 3

= Architectural COMPONENES ..o 4

= Deployment ArChItECIUTE ... 6
Introduction

Agile PLM Data Mart is an operational data store for Agile PLM data integrated with ETL technology
that provides the data foundation for your Enterprise Data Warehouse & Analytics solutions. The
Agile PLM Data Mart stores all relevant data available in the PPM, PC, PCM, PG&C, and PQM
Modules of Agile PLM. The data model for the Agile PLM Data Mart is structured to facilitate
querying and analysis.

The Agile PLM Data Mart operational data store facilitates the following use cases:
1. Tointegrate Agile Data with your Corporate Data Warehouse using corporate ETLs
2. To build and deploy your corporate Business Reporting & Intelligence applications

3. To deploy pre-packaged Agile PLM Business Intelligence (Bl) Solutions

For use case #2, we recommend that you design a Multi-dimensional schema (MDS) layer with the
Agile PLM Data Mart as the staging schema. MDS consists of Facts and Dimension tables and its
design is driven by reporting and business intelligence requirements.

Agile PLM Data Mart Features

o= Agile PLM Data Mart delivers a normalized schema database that captures the business object
data of Common, PC, PCM, PG&C, PPM, and PQM objects and their related data. In addition,
it captures selected data and last modification timestamps which help to further extract data
into any down-stream database system.

o Agile PLM Data Mart packages pre-built ETL that leverages Oracle Data Integrator (ODI)
Technology. Using the ODI operator, you can extract, load, and transform the Agile PLM
transactional data into the Agile PLM Data Matrt.

o Agile PLM Data Mart can be set to extract data from one or more supported Agile PLM
modules.

o Agile PLM Data Mart supports incremental extraction for business object data.

o Agile PLM Data Mart can be set to run a full or Incremental load.

v3.2.0.2 3
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Architectural Components

The following table describes the major components in Agile PLM Data Mart architecture:

Component

Oracle Data Integrator

Agile PLM Data Mart Schema

ODI Repositories

Description

Oracle Data Integrator (ODI) is an application
which uses the Extract-Transform-Load process
to transform data from one schema to another.
ODI uses the ODI Interface and PL/SQL
procedures to implement the Extract-
Transform-Load process.

This is an Operational Data Store built from the
Agile PLM OLTP (Online Transaction
Processing) database.

ODI Repositories maintain all information related
to the definition and execution of ETL
processes.

The following illustration depicts the positioning of various components in the Agile PLM Data Mart

architecture:

Agile Product Lifecycle Management



Chapter 2: Agile PLM Data Mart Overview

Agile PLM Data Mart Architecture
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Deployment Architecture

Application Layer

Oracle Data Integrator (ODI) Operator

Agile PLM Server Java Development Kit (JDK)

ETL: Oracle Data Integrator Agent
Database: Oracle Database Enterprise Edition
DB Schema Users:

1) PLM Datamart Schema

2) ODI Master Respository

3) ODI Work Repository

TNS (1521)

s

Database Layer

Agile PLM Database
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Chapter 3
System Requirements

This chapter includes the following:

B SOftWAre REQUIMEMENTS ......cvivieceeiicte ettt bbb bbb bbb bbb 7
B HarAdWare REQUIFEMENTS ..ot bbb 8
= Installation REQUIFEMENTS ........cciuieieiie e 8

Agile PLM Data Mart can be deployed in different configurations. The amount of time required to
complete an installation depends on the complexity of your deployment.

This chapter describes the minimum software and hardware requirements for an Agile PLM Data
Mart installation.

Software Requirements

The following table lists the software required to install Agile PLM Data Mart 3.2.0.2:
Components Type Supported Versions
Database software Oracle 10g R2 Enterprise Edition
11g R1 Enterprise Edition
11g R2 Enterprise Edition

Note The Agile PLM Source database and the
Agile PLM Data Mart target schema must be
installed with the same database version.

Middleware Oracle Data Integrator 10.1.3.50r 10.1.3.6.2

application (ODI)

Application software ~ Agile PLM 9.2.2.3 (Product Quality only)
9.22.4,92.2.69.3,9.3.0.1,9.3.0.2,9.3.0.3,9.3.1,
9.31.1,9.31.2

Java Platform Java Runtime Environment 1.5.x

software

Note  The Agile PLM Data Mart installer does not support the installation of Data Mart in the
Oracle Database RAC environment.

Agile PLM Data Mart 3.2.0.2 is certified and supported on the following 64-bit Operating System
platforms, unless specified:

= Microsoft Windows Server 2003 (32 and 64-bit)

@ Oracle Enterprise Linux 5

= Sun Solaris 10 (SPARC 64 bit)

v3.2.0.2 7
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=  IBMAIX5.3o0r6
= HP-UX11.31

Hardware Requirements

When choosing a hardware configuration, consider the number of total users, the number of
concurrent users, the size of your Agile PLM database, the number of Agile PLM objects, and
overall activity level. For specific technical guidance, please contact Oracle Technical Support
https://support.oracle.com.

It is required that the computer system on which you are installing Agile PLM Data Mart
components, and the Oracle Database, has at least two physical drives, or two partitions. This
allows you to place the operating system on one drive/partition and use the other for Agile and/or
Oracle components, thus ensuring better performance.

The following are the minimum hardware requirements based on database server size.

System Resources Customer Size

Small Medium Large Extra

Large

CPUs 2 2-4 4-8 8 ++
Disk Space 12GB 24 GB 32 GB 64 GB
Memory (Windows) 2GCB 4GB 6 GB 8 GB
Memory (Linux) 2GCB 4GB 6 GB 8 GB
Memory (AIX) 2GCB 4GB 6 GB 8 GB

For detailed information on database sizing, see the Agile PLM Business Intelligence Capacity
Planning Guide.

Installation Requirements

1. Do notinstall the Agile PLM Data Mart on the same drive as that of the operating system.
2. There must be at least 20 GB of free disk space and 2 GB memory available for Agile PLM Data
Mart.

Important The complete path and folder names should NOT contain any spaces, because ODI
fails to recognize any spaces in folder names or paths.

8 Agile Product Lifecycle Management
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Chapter 4
Installing Agile PLM Data Mart

This chapter includes the following:

m Data Mart INSHAIIET ... 9

= Prerequisite INSAlAtIONS..........ciieir e 9

5 Pre-installation ChECKS ........ciuiiieicc st n e 11
= Installing Agile PLM Data Mart 0N WINAOWS...........coiiiiieeisiise e 12
= Installing Agile PLM Data Mart on Solaris and HP-UX ...........ccccourimininninienenensss s seens 12
= Installing Agile PLM Data Mart ON LINUX.......ccccoriiiiiiieccsesesress et sssssesesessans 13
= Installing Agile PLM Data Mart 0N AlX........ccceriiiiiicccessssiress et sessen 15
= Adding Database Services t0 the LISIENEr. ..o 15
= Manual Installation Steps for DB SChEMA ...........cceuriieririercir ettt sen e 16
= Validating the Agile PLM Data Mart INStallation..............coocrrrniinnieneesseeee e 18
5 BefOre YOU UPGrade.......couiiieiriiiieicsiis et 22
= Upgrading from Agile PLIM Data Mart 3.2..........cccceiiiuiiieiscsss et sss st 22
= Upgrading from Agile PLM Data Mart 3.1.2 0F EQIlIEr ........ccovuirirernncs e 23

Important Itis recommended that the Data Mart Database installation is performed under the
guidance of a DBA.

Important The ETL installation can be performed by anyone who has administrative privileges for
the machine.

Data Mart Installer

The Agile PLM Data Mart Installer is a program that helps in installation of the Agile PLM Data Mart
DB and its components. The installer seeks required inputs about the Source Database, Target
Database and ODI from the user, configures the corresponding properties, and installs all the
components required for Agile PLM Data Mart to perform its functions.

Each installation panel has online help. At any time during installation, you can click Help for more
information about the panel's options.

The Installer deploys the following:

@ Apache Ant

o Agile PLM Data Mart components
o Agile PLM Data Mart Database

Prerequisite Installations

The following products should be installed and configured before you begin installing the Agile PLM

v3.2.0.2 9



Data Mart Setup Guide

Data Mart:

o QOracle Database Server

o Agile PLM Database

@ QOracle Data Integrator

= Java Runtime Environment

If any of these is missing or improperly configured, the Data Mart installation process will fail.

For information on the required versions of the prerequisite products, see Software Requirements
on page 7. For information on how to install and configure these products, go to the Oracle
Technology Network (OTN) Web site http://www.oracle.com/technology/documentation for their
respective documentation libraries.

Note  During the ODI installation, you need to install only the Oracle Data Integrator
component from the installation component checklist.

Oracle Database Server

The Agile PLM Data Mart Installer seeks the paths of the Database Datafile Directory (Destination
Base) and Oracle Home Directory (Destination Home). Therefore, the system where you wish to
install the Data Mart Database, the Target Database, should already have Oracle Database Server
installed.

You are not required to create any DB Schema Users - the installer creates them.

For Data Mart Database creation, make sure that SQLNET.AUTHENTICATION_SERVICES in the
Network Configuration File, sqlnet.ora, is set to (NONE). The sqlnet.ora file is located in the
oracle_home\Network\Admin directory.

For complete information about the Oracle Database and its installation procedures, refer to the
Oracle DB Installation Guide on the Oracle Technology Network (OTN) Web site
http://www.oracle.com/technology/documentation.

Agile PLM Database

The Agile PLM Data Mart extracts, loads and transforms data from the Agile PLM Database, the
Source Database. The Agile PLM Database can be located anywhere in your enterprise, connected
through Local Area Network or Wide Area Network over TCP/IP.

The source PLM DB should already exist. The target Database, the Data Mart Database, however,
can be created in an existing instance, or in a new instance, using the Agile PLM Data Mart
installer.

The Agile PLM Data Mart Installer requires the following information, which should be available from
your Agile PLM Administrator:

* Database Host Name

* Database Port Number

10 Agile Product Lifecycle Management
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¢ Database Name

* Database SID

* Sys User Password

®* System User Password
* PLM DB Username

* PLM DB Password

Oracle Data Integrator

Agile PLM Data Mart operation is based on Oracle Data Integrator (ODI). The Data Mart Schema
requires at least one Master Repository and one Work Repository. These repositories are used by
ODI to operate on data during transformation.

The installer creates the Data Mart Schema on the Target Database Server. ODI should be installed
on the same system where you plan to install Agile PLM Data Mart ETL Components.

For complete information on ODI, refer to its documentation, which is available at Oracle
Technology Network (OTN) Web site.

ODI, and its patch, can be downloaded from the Oracle web site http://www.Oracle.com.

Pre-installation Checks

Make sure the following checks are completed on the machine where Agile PLM Data Mart will be
installed:

@ Minimum hardware and software requirements are met.

= Make sure that you login with a userid that has administrative privileges on the machine where
Agile PLM Data Mart will be installed.

@ Disk compression is disabled.
= PLM Source DB is available and you have passwords for SYS and SYSTEM.
o Correct versions of JRE and ODI are installed.

= ODI_JAVA HOME environment variable contains the path to the installation directory of JDK
1.5.x.

= JAVA_HOME environment variable contains the path to the installation directory of JDK 1.5.x
and JAVA_HOME is added to the PATH environment variable.

o If you are installing from a network drive on Windows, use Windows File Manager to map that
drive to your computer.

= The machines on which you plan to install Agile PLM Data Mart computers and databases
should be dedicated to Agile and should not have any other software installed, unless
otherwise specified. Do not include other database schemas or use the Agile host server as the
primary domain controller (PDC) or dynamic host configuration protocol (DHCP) server.

v3.2.0.2 11
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o Virus Protection should be disabled.

If virus protection is enabled, components used in the installer can be falsely identified as being
infected and lockup the installation. You can turn the virus protection on after the installation is
complete.

Installing Agile PLM Data Mart on Windows

Before you start the Installer, you are required to set the Environment Variables.

To set the Environment Variables:

1. On your desktop, right click on My Computer and select Properties. The System Properties panel
appears.

Click Environment Variables in Advanced tab.

3. Define User variable for Java Home.
Example : JAVA HOME=C:\Java\jdk1.5

4. Set PATH environment variable to include the bin directory path of the JDK installation.
Example : PATH=%JAVA HOME%!\bin

5. Click OK to complete.

To start the Agile PLM Data Mart installer on Windows:

1. Log in as a user with administrative privileges.

2. From Installer base directory in the Installer Disk, <double-click> PLMDM3.2.0.2_Win.exe file.
The Welcome screen appears.

3. Click Next for subsequent screens. Be sure to view the Installer online help for information
about each panel.

4. Click Install to begin the installation.

Installing Agile PLM Data Mart on Solaris and
HP-UX

For the Oracle databases to work properly, the default semaphore settings in Solaris and HP-UX
must be changed. These settings should be reconfigured as follows:

To modify the system kernel parameters:

1. Change to the root user, and back up the letc/system file:
$ su - [Enter]
# cp /etc/system /etc/system save [Enter]

2. Verify the following letc/system kernel parameters. If the parameters do not exist, go to the next
step.

set shmsys:shminfo shmmax = 4294967295

12 Agile Product Lifecycle Management
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set shmsys:shminfo shmmin = 1
set shmsys:shminfo shmmni = 100
set shmsys:shminfo shmseg = 10
set semsys:seminfo semmns = 1024
set semsys:seminfo semmni = 100
set semsys:seminfo semmsl = 500

set semsys:seminfo_semopm = 100
set semsys:seminfo semvmx = 32767
set noexec user stack = 1 (Note:0n Oracle 10g only)

Important If you have been running the host computer as an Oracle database server, you have

to check with your system administrator before changing these parameters. For these
parameter settings, you can also refer to the Oracle database documentation.

Note  Restart the computer if you modify the /etc/system file.

3.

Before you start the Installer program, set the profile as follows -

(Oracle 10g) ORACLE HOME=/u0l/app/oracle/product/10.2.0/db 1; export
ORACLE HOME

(Oracle 11g)ORACLE HOME=/u0l/app/oracle/product/11.1.0/db 1; export
ORACLE HOME

PATH=SPATH: SORACLE HOME/bin; export PATH

JAVA HOME=/u0l/oracle/software/jdkl.5.0 15; export JAVA HOME
ODI_JAVA_HOME=$JAVA_HOME; export ODI JAVA HOME
ODI_HOME=/u0l/oracle/software/odi/oracledi; export ODI_ HOME

To start the Agile PLM Data Mart installer on Solaris or HP-UX:

1.

Log on as a user with full permissions.

Important The user must have full permissions (-rwx) for all the folders of the Oracle DB
and ODI or the Installation will fail.

Open a terminal window.
Change to the directory where you downloaded the installation file.

At the prompt, execute the PLMDM3.2.0.2_Sol.bin file for Solaris or the PLMDM3.2.0.2_hpux.bin file
for HP-UX.

The Welcome screen appears.

Click Next for subsequent screens. Be sure to view the Installer online help for information
about each panel.

Click Install to begin the installation.
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Installing Agile PLM Data Mart on Linux

For the Oracle databases to work properly, the default semaphore settings in Linux must be
changed.

To modify the system kernel parameters:

1. Login as the root user, and back up the /etc/sysctl.conf file:
$ su - [Enter]
# cp /etc/sysctl.conf /etc/sysctl.conf save [Enter]
2. Verify the following /etc/sysctl.conf kernel parameters. If the parameters do not exist, go to the

next step.

kernel.shmall = 2097152
kernel.shmmax = 2147483648
kernel.shmmni = 4096

kernel.sem = 250 32000 100 128
fs.file-max = 65536
net.ipv4.ip local port range = 1024 65000
net.core.rmem default = 1048576
net.core.rmem max = 1048576
net.core.wmem default = 262144
net.core.wmem max = 262144

Important If you have been running the host computer as an Oracle database server, you have
to check with your Linux system administrator before changing these parameters. For
these parameter settings, you can also refer to the Oracle database documentation.

Note  Restart the computer if you modify the /etc/sysctl.conf file. Alternatively, you can use the
sysctl command to modify the semaphore parameters immediately. However, using
systcl command does not make the changes permanent. Permanent changes are
required in /etc/sysctl.conf file.

3. Before you start the Installer program, set the profile as follows:
(Oracle 10g) ORACLE HOME=/u0l/app/oracle/product/10.2.0/db 1; export
ORACLE HOME

(Oracle 11g)ORACLE HOME=/u0l/app/oracle/product/11.1.0/db 1; export
ORACLE HOME

PATH:$PATH:$ORACLE_HOME/bin; export PATH

JAVA HOME=/u0l/oracle/software/jdkl.5.0 15; export JAVA HOME
ODI_JAVA HOME=$JAVA HOME; export ODI_JAVA HOME

ODI HOME=/ul0l/oracle/software/odi/oracledi; export ODI_ HOME

To start the Agile PLM Data Mart installer on Linux:
1. Log on with root privileges.

2. Open a terminal window.
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Change to the directory where you downloaded the installation file.
At the prompt, execute the PLMDM3.2.0.2_Lin.bin file.
The Welcome screen appears.
5. Click Next for subsequent screens. Be sure to view the Installer online help for information
about each panel.

Important The user should have full permission (-rwx) for all the folders of the Oracle DB and
ODI or the Installation will fail.

Installing Agile PLM Data Mart on AIX

To start the Agile PLM Data Mart installer on AIX:
1. Log on as a user with full permissions.

Important The user must have full permissions (-rwx) for all the folders of the Oracle DB
and ODI or the Installation will fail.

Open a terminal window.

Change to the directory where you downloaded the installation file.
At the prompt, execute the PLMDM3.2.0.2_Aix.bin file.

The Welcome screen appears.

5. Click Next for subsequent screens. Be sure to view the Installer online help for information
about each panel.

6. Click Install to begin the installation.

Adding Database Services to the Listener

Note  Thisis only applicable for Agile PLM deployments creating a new Oracle PLA Data Mart
database instance.

Upon completion of the Installation process, you are required to add database services to the
Listener. Use the Oracle Net Manager to specify:

o Global Database Name [eg, PLMDM]

@ Oracle Home Directory [eg, D:\ORACLE\product\10.2.0\db_1]

o SID [eg, PLMDM]

Stop and restart the Listener after you have added the services.
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Manual Installation Steps for DB Schema

If you selected the option Generate SQL Scripts in the Select Data Mart Schema panel during
installation, the Installer generates a set of SQL files and stores them in the Schema folder under the
Data Mart Home directory. You need to run them in SQL*Plus in the order given to manually create
the Agile PLM Data Mart database schema.

Note  The database needs to be already created before performing these steps.

The following are the different possibilities of creating the Data Mart schema using manually
generated Install Scripts:

Scenario 1

Generate the scripts using installer in system A where Data Mart Schema is created and execute the scripts
manually.

In SQL*Plus, connect to the Data Mart database using the Data Mart User Name and Password.

Before doing so, set the Oracle SID environment variable as follows:

IWindows set oracle_sid = <sid_name>

Solaris/Linux export ORACLE_SID = <sid_name>

1. Run TableSpaceCreation.sql to create Tablespace. If the tablespace already exists, skip this step.
Run UserCreation.sql to create Users.

2
3. Run ODM.sql to install the Operational Data Mart (ODM).
4. Run ODM_DDL_COMMENTS.sql script to add comments for the tables. This step is optional.

Note  The given sequence of execution is very important or the installation will fail. If you run
the scripts on a machine different from where they were generated, verify the
parameters, including sys and system password.

Scenario 2

Generate the scripts using installer in system A and create the Data Mart Schema on another system using the
generated scripts.

If you generate the scripts on System A and run them on System B, then you need to replace the
scripts in the same location on System B, because the .sql files contain an absolute path. Or, you
can change the directory path in the .sql files to any valid directory.

Example :

Generate the scripts on System A in directory F:\PLM_DataMart. Copy the scripts to System B to
the location F:\PLM_DataMart. If F: drive does not exist in System B, copy the scripts to any valid
directory (example : D:\PLM_DataMart) on System B and change the directory path in the following
.sql files:

= SingleSchemacCreation.sql (for Single Schema Option)
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= UsersCreation.sql(for Default Schema Option)
o TablespaceCreation.sql(optional)

o Odm.sql

Note  Follow the steps outlined in the Scenario 1 to manually install the Data Mart schema.The
generated scripts can be run on all operating systems.

Setting Database Privileges

The following table illustrates the privileges that a database administrator can grant on a single
schema installation:

Schema Database Privilege Purpose
ODM GRANT CONNECT,RESOURCE to ODM; Enable connection to the schema
GRANT CREATE DATABASE LINK TO ODM Create DB link for every full ETL run
GRANT DROP PUBLIC DATABASE LINK TO Drop DB link
ODM
GRANT CREATE SYNONYM TO ODM Create synonym for Source table in Target
Schema
GRANT CREATE PUBLIC SYNONYM TO Create public synonym for Source table in
ODM Target Schema
GRANT ANALYZE ANY TO ODM Analyze the i$ table during the CDC ETL run
GRANT DROP PUBLIC SYNONYM TO ODM Drop Synonym
GRANT CREATE TABLE TO ODM Create Table

The following table illustrates the important database privileges required for multiple schema
installation:

Schema Database Privilege Purpose

ODIWORK GRANT CONNECT, RESOURCE TO ODIWORK
GRANT ANALYZE ANY TO ODIWORK WITH 0Dl tool analyzes temp tables during CDC ETL
ADMIN OPTION run

ODM GRANT CONNECT, RESOURCE TO ODM
GRANT DROP PUBLIC DATABASE LINK TO
ODM Drop DB Link for every Full ETL run
GRANT CREATE ANY INDEX TO ODM Create an index in WorkRep Schema for i$

tables from ODM Schema
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GRANT INSERT ANY TABLE TO ODM

Insert tables such as i$,e$, and ¢$ in Work
Repository Schema from ODM schema

GRANT ANALYZE ANY TO ODM

ODI Tool analyses the i$ table during CDC ETL
run

GRANT DROP ANY SYNONYM TO ODM

Drop a synonym in WORKREP schema from
ODM schema

GRANT CREATE DATABASE LINK TO ODM

Create a DB Link

GRANT DELETE ANY TABLE TO ODM

Delete the deleted records from i$ in WORKREP
schema from ODM schema. This is used in CDC
ETL run

GRANT UPDATE ANY TABLE TO ODM

Update the updated records from i$ in
WORKREP schema from ODM schema. This is
used in CDC ETL run

GRANT DROP ANY TABLE TO ODM

Drop i$ table in WORKREP schema from ODM
Schema

GRANT CREATE ANY TABLE TO ODM

Create a table like i$,e$,c$ in WORKREP
schema from ODM Schema

GRANT CREATE ANY SYNONYM TO ODM

Create a synonym for Source Table in
WORKREP schema from ODM schema

GRANT SELECT ANY TABLE TO ODM

Select a table like i$_listname in WORKREP and
populate the data in ODM_LISTNAME in ODM
schema .The select query is executed from ODM
schema.

GRANT EXECUTE, DEBUG ON
SYS.DBMS_PIPE TO ODM

This privilege is used for PL/SQL Logger

GRANT EXECUTE ON SYS.DBMS_SYSTEM
TO ODM

This privilege is used for PL/SQL Logger

GRANT CREATE PUBLIC SYNONYM TO ODM

This privilege is used for PL/SQL Logger

ODIMASTER

GRANT CONNECT, RESOURCE TO
ODIMASTER

Validating the Agile PLM Data Mart Installation

Upon completion of installation, you may verify if it was successful or not. Perform the following

checks:

o Runthe SQL @ Work Repository schema

select count (scen no) from SNP SCEN;

o Check the following log files, located in the logs folder under Data Mart Home directory, for any

errors:

e DatamartETLInstall.log file for information pertaining to installation of ETL components

18
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e DatamartDBInstall.log file for information on DB creation
*  Datamartinstall.log file

Install Directory Structure

After installation, the Agile PLM Data Mart install directory structure, with the outlined content,
should contain the following subdirectories:

ant Ant installation required for Agile PLM Data Mart installation

bin Contains configuration tools and miscellaneous utilities

config Contains all Agile PLM Data Mart configurations including ANT install configuration file
install Installation components

jdk Java run-time used by the ODI

lib Contains all dependent libraries specially used by Agile PLM Data Mart

logs Install logs

schema Contains SQL scripts for creating instance

uninstaller Contains executable file to un-install the software

Database Schemas

Check to ensure that the following database schemas are created successfully:
o Agile PLM Data Mart Database

o ODI Master Repository

@ ODI Work Repository

Besides making sure the directory structure and schemas are properly created, the following
validation checks should be done to make sure Agile PLM Data Mart is installed properly:

Verifying Agile PLM Data Mart Schema

On the Agile PLM Data Mart Database schema, make sure
1. The ODM_LISTDIM_CTL table is populated with seed data.
2. The PARAMETER table is created and populated with one row.

3. PL/SQL packages (4), procedures (17) and functions (7) are created. Login to ODI Designer to
verify.

4. The TLOG table, VLOG view and TLOG synonym are created.
If any of the above verifications fail, look for any Oracle Database errors in the Datamartinstall.log file.

Datamartinstall.log file is located in the <Agile PLM Data Mart Home> \logs folder. It includes
information log details for the following installation steps:
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@ Creation of Users (Agile PLM Data Mart Schema User, ODI Master Repository user, ODI Work
Repository User)

= PL/SQL logger (Analytics Log user, creation of tables TLOG)
o Agile PLM Data Mart database creation
o ODI Repository creation

= ODI Physical connection configuration, Logical connection configuration, importing Model
folder, Project folder

Verifying ODI Repositories

Log into ODI Designer to verify the following:
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1. Projects tab lists the AGILE PLM ANALYTICS project and the project has following packages
under the Agile Datamart Folder:

=1 _J.&maman Folder
= B Packages ﬁ
[+ B odi_pkg_DATAMART_LOAD

- 4 odi_pkg_ODM_COMMON_9222_cdc
] odi_pkg_ODM_COMMON_8222_full
- 73 odi_pkg_ODM_COMMON_9223_cdc
- 13 odi_pkg_ODM_COMMON_9223_full
] odi_pkg_ODM_COMMON_9224_cdc
] odi_pkg_ODM_COMMON_9224_full
5 odi_pkg_ODM_COMMON_93_cdc
15 odi_pkg_ODM_COMMON_93_full

- B odi_pkg_ODM_COMMON_cdc

- 4 odi_pkg_ODM_COMMON_ful

- 73 odi_pkg_ODM_METADATA_cdc

- 3 odi_pkg_ODM_METADATA_ful

5 odi_pkg_ODM_PCM_93_cdc

5] odi_pkg_ODM_PCM_33_full

godl _pkg_ODM_PCM_EXEC_cdc

- 4 odi_pkg_ODM_PCM_EXEC_ful

- B odi_pkg_ODM_PCM_cdc

5 odi_pkg_ODM_PCM_full

5] odi_pkg_ODM_PC_9223_cdc

- I odi_pkg_ODM_PC_9223_full

- 3 odi_pkg_ODM_PC_9226_cdc

- 3 odi_pkg_ODM_PC_9226_full

3 odi_pkg_ODM_PC_93_cdc

- 3 odi_pkg_ODM_PC_93_full

5 odi_pkg_ODM_PC_cdc

5 odi_pkg_ODM_PC_full

- 73 odi_pky_ODM_PGC_EXEC_cdc

- 13 odi_pkg_ODM_PGC_EXEC_ful

5 odi_pkg_ODM_PGC_cdc

] odi_pkg_ODM_PGC_full

- odi_pkg_ODM_PPM_8222_cdc

{1l

F

2. Open ODI Topology Manager and make sure the Source PLM Database SID and schema user
details are populated:

a. Double-click Physical Architecture tab > Technologies > Oracle > SRC_CONN_PHYSICAL and verify
Instance and Schema name details in the Definition tab.

b. Click the JDBC tab and verify that the JDBC URL is pointing to the correct SID on the
Source PLM Database machine.
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Before you Upgrade

Make sure one ETL load completes successfully in the current version of Agile PLM Data Mart.

Upgrading from Agile PLM Data Mart 3.2

Perform the following steps to upgrade Agile PLM Data Mart 3.2 or 3.2.0.0.1 to Agile PLM Data
Mart 3.2.0.2:

1.

Set the PLMDataMart_Home environment variable to point to the directory where the existing
Agile PLM Data Mart 3.2 software is installed.

For example:
Windows: Set PLMDataMart_ Home=D:/PLMDataMart
Linux/Solaris: export PLMDataMart_Home \home\oracle\PLMDataMart

2. Copy the DM3202_Patchlinstaller.zip file into the existing PLM Data Mart install directory
3. Unzip the DM3202_Patchinstaller.zip file:
a. Inthe Command Prompt or terminal window, change to the directory where you saved the
DM3202_Patchinstaller.zip file
b. Enter the following command to extract the contents of the file:
jar -xvf DM3202 Patchlnstaller.zip
c. After you extract the files, the following folders are displayed:
= bin
= Patch
\etl
\schema
4. Using the Command Prompt or shell, login to the Data Mart schema and run the
ODM_3202.sql script, located in the %PLMDataMart_Home%\Patch\schema directory on
Windows or the $PLMDataMart_Home/Patch schema directory on Linux and Solaris:
SQL> @ODM 3202.sql
5. Replace the following tokens in the Windows batch file,
%PLMDataMart_ HOME%\bin\ImportODMComponents_patch.bat or the Linux/Solaris shell file
$PLMDataMart_Home/bin/ImportODMComponents_Patch.sh:
a. Replace <<AA HOME> with the Data Mart home directory path.
b. Replace <ODI_WORK> with the ODI Work Repository name (default=WORKREP).
Note  <ODI_WORKS> is the logical name of the work repository, but is not the ODI Work
schema name.
6. Run the ImportODMComponents_patch.bat (or .sh) file:
On Windows:
Note  Make sure that %ODI_HOME%\bin is present in the operating system path.
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cd %$PLMDataMart Home$%\bin

ImportODMComponents patch.bat > ..\logs\Patch.log

On Linux or Solaris:

$ cd $PLMDataMart Home/bin

$ chmod +x *.sh

$./ImportODMComponents patch.sh > ../logs/Patch.log
Note  Make sure $ODI_HOME is present in the operating system path.

7. Using the Command Prompt or shell, login to the Data Mart schema and run the
Post_Installation.sql file, located in the %PLMDataMart_Home%\Patch\schema directory on
Windows or the $PLMDataMart_Home/Patch/schema on Linux and Solaris.

8. After running the Post_Installation.sql file, run the following statements to confirm successful
execution:

® sgl> select * from dm_load_ctl;

* sgl>select * from odm_data_dictionary where tgt_table like '%_P4';

* sgl> select * from user_tables where table_name like '%_P4';

® sgl> select * from user_tables where table_name like '%_P4%_MAP";
® sgl> select * from odm_flexcols_metadata;

Note  All of the statements should not return any rows.

Upgrading from Agile PLM Data Mart 3.1.2 or
Earlier

The Agile PLM Data Mart 3.2.0.2 installer does not provide upgrade software or scripts to upgrade
any customizations done on the Data Mart schema or ODI ETL components installed with Agile
PLM Data Mart 3.1.2 or earlier versions.

If you are upgrading from a previous release of Agile PLM Data Mart, use the following steps as
guidelines for upgrading your existing Agile PLM Data Mart installation:

Note  These steps are applicable only if you customized any schema objects or ODI-related
objects in a previous release.

1. Backup the Data Mart schema, including any views or downstream ETL developed against the
Data Mart schema.
Note Itis best practice to package all schema customizations into one or multiple upgrade
SQL files that can be run directly after installing Agile PLM Data Mart.
2. Backup the ODI Master and Work repository schema objects and note all ODI ETL
customizations developed against Agile PLM Data Mart.

3. Drop, recreate, and provide appropriate database schema user privileges for Data Mart, ODI
Master and Work schemas.
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Note  Drop and recreate a single schema if the previous deployment used a single
schema for all three schema objects.

4. |Install Agile PLM Data Mart using the same schema configurations you used in the previous
release.

5. Re-implement schema customizations including a refresh (or recreate) of views and
downstream ETL developed on the Data Mart schema.

6. Import or re-implement any customization done on the ODI ETL.

Test the installation of Agile PLM Data Mart and all customizations.
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This chapter includes the following:
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= Changing List Names in Dimension Table
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= Enabling and Disabling ETL for PLM MOGUIES ...........criiiiirimiiriersireees e 27
= Changing the Agile PLM Data Mart PASSWOITS.............ccccoieirieriiniiciesecie ettt esse bbb s 28

List Dimension Configurator

The Agile PLM Data Mart Configurator is a tool bundled with the Agile PLM Data Mart software. The
tool provides the flexibility for customers to change the dimension table names of any of the "out of
the box" list in the Agile PLM Data Mart schema. These List Dimension tables are named according
to their List Names. You may rename them in accordance with your own naming conventions.

The tool also enables customers to provide new dimension table names for the customer configured
lists in Agile PLM.

During ETL execution, the Agile PLM Data Mart application creates separate database tables in the
Agile PLM Data Mart schema for each list Dimension. These tables serve as the master data
source of list items. The Dimension Table Names for Lists are stored in table ODM_LISTDIM_CTL in
the Agile PLM Data Mart schema.

To use the List Dimension Configurator, follow these steps:

1. Execute the Configurator.bat file, located in bin folder of the Data Mart Home directory.
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The configurator console appears.

:: PLM Data Mart Configurator ;-

List D List Mame List Dimension Mame
2010 Action Type List QOM_ACTION_TYPE_D

203|Publisher Actions List ODM_PUB_ACTION_D

281 |Product Lines oD _PRODUCT _LIMES_D

A1 |Part Category ODM_PART _CATEGORY D

321 |Document Categary QONM_DoOc_CATEGORY_D

331 |Change Function ODM_CHMG_FUNCTION_D

351|Reason Code oDM_REASOMCODE_D

353 |5tate List CDM_STATE_D

361 |Al User Objects CDM_USERS_OBJ_D

65| Country CDM_COUNTRY_D

411|Change Category CDM_CHARMGE_CATEGORY_D

421|5ize ODh_SIZE_D

431 |Disposition CDM_DISPOSITION_D

730|Change Analysts CDM_CHARMGE_AMALYST_OBJ..

7al|Component Engineers QOM_COMPORENT_EMGRS_O..
1442 Manufacturers Type List QOM_MAMUFACTURERS_TYFE...
14450|Manu Crders Type List QOM_MFR_ORDERS_TWFE_O..
1483 |Manu Parts Type List CDM_MANL_PARTS_TYFE_OE..

Save Close

It displays all the List IDs, List Names and List Dimension Names, sorted by List ID. You can
also sort the displayed data on List Name or List Dimension Name too.

2. ldentify the desired List Name whose List Dimension Name you wish to modify or rename.
3. Click in the corresponding cell under List Dimension Name column.

4. If the cell is empty, enter the desired name. Otherwise, select the existing name, delete and then
enter a new name.

Note  The List IDs and the correponding List Names cannot be modified.
5. Click the Save button. The new values are stored in the List Dimension Control table -
ODM_LISTDIM_CTL in the Data Mart.

Note  The Save button remains inactive until you edit any List Dimension Name. Undo, or

Ctrl-Z, does not work.

6. Continue editing the List Dimension Names or click the Cancel button to exit.

Note Any updates made to List Dimension Names using Configurator will be processed
during the next ETL run.
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The ODM_LISTDIM_CTL table stores the latest List Dimension Names. The existing data is copied
into its backup table, ODM_LISTDIM_CTL_BK, along with the timestamps of each modification
before it is committed. Thus, it maintains the entire history of each and every earlier List Dimension
Name, allowing you to switch back, if you want to.

Changing List Names in Dimension Table

When a new List is added in Agile PLM, the Data Mart ETL dynamically adds the appropriate
dimension table name to the ODM_LISTDIM_CTL table and creates it during the next ETL run. You
can change the name of this dimension table after an ETL run is completed.

To create a new List in Agile PLM and also change its dimension table in Target Data Mart:
1. Create a new List in Agile PLM Administrator.

2. Run Agile PLM Data Mart ETL.

3. Run Configurator and identify the row of the newly created List in Configurator.

4

(Optional) Delete the dimension table that was created during the previous ETL run. This step
prevents schema from having orphan dimension tables.

Change the Dimension Table name for the newly created List.

Once changes are completed and saved, run Agile PLM Data Mart ETL.

Validating Dimension Tables

When you make any changes to Dimension table names using Configurator and you have not
deleted previously created dimension tables from the Agile PLM Data Mart schema, anyone with
Oracle Database Administration skills can take the following steps to identify and remove unused
dimension tables from the Agile PLM Data Mart schema:

1. Run the following SQL query to identify all Dimension tables
SELECT LIST DIM from ODM LISTDIM CTL BKP
WHERE
LIST DIM not in
(SELECT LIST DIM from ODM LISTDIM CTL)

2. Make sure the table names returned by this query are not used by any downstream ETL
application.

3. Drop every table identified as not used by Agile PLM Data Mart or the downstream ETL
application from the Agile PLM Data Mart schema.

Enabling and Disabling ETL for PLM Modules

You can enable or disable ETL for the Agile PLM modules (PC, PPM, PQM, PCM, PG&C) to
selectively extract their data from the PLM database server. The properties of the Enabled/Disabled
modules are stored in the DataMartConfig.Properties file in the Config folder under the Agile PLM Data
Mart Home Directory.
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To Enable/Disable ETL for the modules:
1. Open the DataMartConfig.Properties file in a Text Editor.

2. Go to the section ###PLM Module###. The PLM modules are listed here.
PQM=Y
PPM=Y
PC=Y
PCM=Y
PGC=Y
3. Change the property values to Y or N.
The properties value Y enables the module, and N disables.

4. Run the LoadParameters script located in the bin directory under the Agile PLM Data Mart Home
directory.

5. Or, change and commit the values (Y or N) in the Parameter Table.

Note  The module property cannot be empty. It should be either Y or N.

Changing the Agile PLM Data Mart Passwords

Password changes are stored directly in the database. However, the changed passwords should
also be stored, in encrypted form, in the DataMartConfig.properties file. This is necessary for the
following reasons:

o The LoadParameters.bat uses the access information (username, password) from the properties
file to enable or disable the modules.

= The Configurator.bat file uses the access information (username, password) from the
properties file to configure the new List Dimension Names.

Therefore, any changes in any passwords in the database should also be reflected in the properties
file. The encryption of passwords is required for security reasons.

Changing a password entails a two-staged action:

1. Generate an encrypted string for a character password using DMEncoder.bat in Windows, or
DMEncoder.sh in Solaris/Linux/AlX.

2. Replace the existing encrypted password string in the DataMartConfig.properties file with the
new encrypted string.

Note  The LoadParameters.bat file uses this properties file to change the PLM modules.

To change a password:
1. Go to the bin folder in the Agile PLM Data Mart Home directory

2. Run the batch file along with a desired password, as follows:
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dmencoder <pwd>

where <pwd> is an alpha-numeric character string password.
An encrypted string appears.

Select and copy the encrypted string.

Open the DataMartConfig.properties file, located in the config folder in the Agile PLM Data Mart
Home directory, in a text editor.

Delete the password that you wish to change.

Paste the new encrypted string and save and close the file.

Note  To reflect the changed password(s) in ODI, refer to the ODI Administration Guide.
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Executing ETL

This chapter includes the following:
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= EXECULING ETL fIOM OD ...
= Executing ETL from Command Prompt

You can perform Extraction, Transformation and Loading (ETL) of PLM data from the source
database to the Agile PLM Data Mart Database by running the ETL tasks. These tasks are installed
in the Agile PLM Data Mart Home directory and can be run inside ODI or from a command prompt.

Important Agile PLM Data Mart does not guarantee data consistency in the ODM schema if
there are any data changes to Agile PLM while ETL is running. It is recommended that
ETL runs are scheduled when Agile PLM systems are idle.

Before running any tasks, you are required to setup ODI users.

Setting up ODI Users

Agile PLM Data Mart is based on the Oracle Data Integrator. To run ETL tasks and operate on data,
you are required to use ODI.

Note  ODI User setup requires the information entered during the Data Mart installation, such
as, user names and passwords.

To configure a user:
1. On Windows, run the program Operator from Start > Programs > OracleODI > Operator
The Oracle Data Integrator Login screen appears.

2. Click New to create a new Work Repository Connection.
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~ Oracle Data Integrator Connection

~ Database Connection [Master Repositary)

= Work Repository

The Work Repository Connection screen appears

Work Repository Connection

Login Mame hepns'rtl:nry

Lizer [EUPERYISOR

Pazsward f*******

User {ODIMASTER

Pazsvword l’********

Driver List [ Oracle JDBC Driver { ',]

Driver Mame ljrau:le.jdhu:.driver.OracIeDriver

LIl idbc:nracle:thin:@ﬁhust:: =port=:<sid=

Repositary Mame i'l.-“-.l'CJHKREF‘

fRwTE— e — p—

3. Enter Login Name, User name and password for ODI connection.
These can be of your choice. The default User Name is SUPERVISOR and the password is
SUNOPSIS (case sensitive).
Note  To configure additional users or change password for SUPERVISOR, refer to the
ODI documentation.
4. Enter the User name and password for Master Repository DB connection that you specified
during installation.
5. Select Oracle JDBC Driver from Driver List
The Driver Name field is automatically filled with oracle.jdbc.driver.OracleDriver.
6. Enter the following URL:
jdbc:oracle:thin:@<host>:<port>:<sid>
where
<host> Host name of Agile PLM Data Mart DB
Server
<port> Port Number of Agile PLM Data Mart DB
Server
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<sid> SID or the Instance name of Agile PLM
Data Mart DB

Enter the Repository Name for Work Repository.
Click Test button to verify the connection works.
Click OK. You are prompted to enter the Work Repository Password.

10. Enter the Work Repository Password that was assigned during the Data Mart installation and
click OK.

11. Click OK to finish.
Note  For complete information on installation and usage of ODI, refer to its documentation

available at the Oracle Technology Network (OTN) Web site
http://www.oracle.com/technology/documentation.

Executing ETL from ODI

Note If you want to see the status of all the tasks that are under execution, increase the
Operator Display Limit to 1000 (the default value is 100). In ODI Operator, go to File Menu
> User parameter >Set operator Display limit and change the value.

The full or incremental load brings in all relevant data that were modified or added after the latest
data load. If you want to run a FULL_LOAD, set Full_Load to Yes in PARAMETER table of the Agile
PLM Data Mart schema.

To modify the parameter table:

1. Login to Agile PLM Data Mart database.

SQL> update PARAMETER set FULLiLOAD='Y';
SQL> commit;

To execute ETL from ODI, follow these steps:

1. Launch ODI Operator and select login, which is Repository Name
a. The username and password populate automatically. Click OK.
b. Go to the Scenarios tab.

2. You will see all the components listed in the Left Frame.
a. Right-click on DATAMART_LOAD Version 001 component and select Execute. The Execution
window displays.
Click OK. The Sessions Started dialog appears.
Click OK. The ETL process begins.

Note  The Agile PLM Data Mart load does not physically delete any data, which are either soft
or hard deleted in the PLM source database. The deleted items are flagged with the
delete_flag set to 1.
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Executing ETL from Command Prompt

To execute ETL from a command prompt:
1. In Windows, open a Command Prompt window.

2. Change the directory to the bin folder in your Data Mart Home Directory, eg,
d:\PLMdatamart\bin

3. Enter the following on the command line:
startdm DATAMART LOAD 001 PLMDM
where
startdm is the batchfile that executes ETL tasks
DATAMART_LOAD is the ETL task
001 is the version number of ETL task
PLMDM is the ETL context
The ETL process starts.

To view the status of an ETL process:

1. Launch ODI Operator and select login, which is the Repository Name.
The username and password populate automatically.
Click OK.

3. Go to the Sessions List tab and select All Executions in the left frame, which shows all the running
tasks.

4. Or, you can go to the Hierarchical Sessions tab and select Status or All Executions in the left frame
to check overall top level progress.
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This chapter includes the following:
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This section lists the prerequisites, installation procedure, and post-installation guidelines for
installing Agile PLM Data Mart Patch 3.2.0.2 on Real Application Cluster.

Prerequisites

1. Install Oracle 11gR2 clusterware. For more information, see Oracle 11gR2 documentation.

2. Install supported ODI version. For more information, see ODI Installation documentation.

Installing Agile PLM Data Mart Patch 3.2.0.2 on
Real Application Cluster

1. Create TNS entries for Agile PLM source on each node in the cluster.

Note ETL will fail if the TNS entries are not created.

2. Install Agile PLM Data Mart in any of the nodes in the cluster environment by following the
installation procedure provided in the Agile PLM Data Mart Setup Guide.

Post Installation Steps

After you install Agile PLM Data Mart on RAC, perform the following steps:
1. Launch the ODI Operator.

Note  Agile PLM Data Mart can be installed on any of the nodes in the cluster.

2. Replace the URL in the Work Repository Connection window with the corresponding details of
the two nodes. The URL is displayed in the following format:

Jdbc:oracle:thin:@<host>:port:sid
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To replace the URL, see the example below:

Jdbe:oracle:thin:@(DESCRIPTION=(LOAD_BALANCE=on)
(ADDRESS=(PROTOCOL=TCP) (HOST=<NODE # 1 HOSTNAME> (PORT=1521))
(ADDRESS=(PROTOCOL=TCP)(HOST=<NODE # 2 HOSTNAME> (PORT=1521))
(CONNECT_DATA=(SERVICE_NAME=<SID NAME>)))

Note  For more information on setting up ODI Users, refer to the "Setting up ODI Users"
section in the Agile PLM Data Mart Setup Guide.

3. Launch the Topology Manager and update the target JDBC database configuration for Staging.
Please refer to the example provided in Step 2.
Note  For more information, see ODI documentation or contact Oracle Support.
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Troubleshooting

This Appendix includes the following:
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Installation Issues

Unsupported Operating systems error

| use Windows XP operating system. | get a warning that states 'Unsupported Operating System'
when | run the PLMBISetup_Win.exe file. There are options to quit or continue the installation. If |
continue the installation what is the impact?

Cause:

You are running the installer on a computer that is not a Server. This warning indicates that Oracle
does not support any issues that might come up after the installation of the software on a desktop at
work or a Personal Computer (PC) used for software demonstrations.

Action:

There are no known adverse impacts if you continue with the installation. This warning does not
appear if you install Oracle Product Lifecycle Analytics on a Server.

You can choose to quit the installation if you do not want to install the application on your work
desktop or Home PC.

Installation Unsuccessful

During the installation of Oracle Product Lifecycle Analytics, | get an error message: Installation
unsuccessful.

Action:

If the Database and ETL are installed together, check the Logs\DataMartinstall.log file. If the
Database and ETL are installed separately, including on different machines, check the database
install log at logs\DatamartDBInstall.log and the ETL install log at logs\DataMartETLInstall.log.

Repeat the installation using the latest download of the PLMBISetup file.

Unable to select the same installation directory if | install Oracle Product Lifecycle Analytics database and ETL
components separately

| have installed the Product Lifecycle Analytics database. | am unable to install the Product Lifecycle
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Analytics application in the same system and in the same directory where the database is installed.
Action:

If you are installing both the database and ETL on the same system, you can select both options
together in the installer. If you install them separately in the same system, you will need to use two
separate install folders.

Page cannot be displayed

| completed the installation successfully but when | launch the Oracle Product Lifecycle Analytics
application URL, | get a 'Page cannot be displayed' screen.

Action:

Make sure to start the following services in the listed order:
1. OC4JdorllS

2. Oracle Bl Java Host

3. Oracle Bl Server

4. Oracle Bl Presentation Server

Installer failed to create Data Mart schema, ODI Work repository and/or ODI Master repository
schemas

Look for possible root causes in Datamartinstall.log, located in the logs folder of the Oracle PLA
Data Mart install home directory.

Possible root causes could be:

* Database version specified is different from the one installed in the system. For example,
Oracle 10g option is selected during installer while the machine has Oracle 9i.

* Path specified for Oracle Target DB Tablespaces could be invalid.

* Oracle Database path specified is incorrect.

* Database Instance exists, but the System user does not have proper privileges required to
create and grant appropriate roles to schema users.

Incorrect installation of Oracle database

Database name specified when you create the database, may pre-exist. Choose another data
base name to resolve the issue.

Installer failed to create ODI Work repository and ODI Master repository

Look for possible root causes under ODIRepCreation: tag in Datamartinstall.log:

*  Work Repository and Master Repository schemas are not created for possible root causes
outlined in #1.

* Tablespace specified for Work & Master repository are invalid.

e JAVA HOME and JAVA_ODI_HOME environment variables are incorrect.

* Specified ODI directory is incorrect or ODI is not installed at specified path.
ODI Project "AGILE PLM ANALYTICS" does not have any packages

Besides the root causes outlined in #2, look for errors under ODI-PHY-Creation section in
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Datamartlnstall.log for other issues:

* OdilmportObject failed to execute for incorrect JRE specified

* JDK version specified is either less than 1.5.x or 1.6 or above.

* Specified Work Repository Name is already used in existing ODI

* ODI already has projects that have conflicting Work and Master Repository IDs. Oracle
PLA Data Mart uses following repository IDs:

Work Repository ID = 102
Master Repository ID = 103

Data Mart installation failed in Solaris.

If you are using Solaris installer for ODI, the Data Mart Installation fails. To avoid this
installation error, use ODI Linux installer and manually install ODI as outlined in the ODI
Installation Guide.

Installation fails with non-default Listener

If you are installing Oracle PLA Data Mart on a database with a non-default listener on a non-default
port, make sure the listener is added to the listener.ora file in order to be recognized by the installer.

Installer unable to find Oracle Database Server

If you are installing Oracle PLA Data Mart on a 64-bit Windows system, an error message may
display stating that the Oracle Database server was not found, even though it is installed. Ignore
this message and continue with the installation.

Data Mart database instance not recognized by Oracle Database Configuration Assistant when using the Oracle
Product Lifecycle Analytics Installer.

A user with Admin privileges must manually add the database as an entry to the oratab file, located
in either the /etc or var/opt/oracle/ directory, based on the operating system.

Unable to update RPD and Web Catalog

The Oracle Product Lifecycle Analytics Installation is unsuccessful. | am unable to update RPD and
Web Catalog.

Action:

Ensure that the OC4J server is running before you begin the installation.

ETL Runtime Issues

Connection Identifier error on ETL run with Agile PLM source (Agile PLM)

When | run ETL, the ODI_INT_CREATE_DBLINK task displays a connection identifier error
message.

Cause:

The TNSNAMES.ORA file does not have the correct information that enables connection to the
source database.
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Action:

Add a TNSNAME entry in the target database that points to the source database before you run the
ETL.

If the database SID name of the source and target database are different (Example: Source SID =
AGILE9 and Target SID = PLMDM), then modify the TNS Service name to the name of the source
database name in the tnsname.ora file, like AGILE9, in this example.

If the database SID name of the source and target database are the same (Example: Source SID =
AGILE9 and Target SID = AGILEDY), to eliminate DBLINK errors:

1. Modify the TNS entry as follows:
AGILE9 LAB1 =
(DESCRIPTION =
(ADDRESS_LIST =
(ADDRESS = (PROTOCOL = TCP)(HOST = LAB1)(PORT = 1521))
)
(CONNECT_DATA =
(SERVICE_NAME = AGILE9)

)
)

2. Start > Oracle > Oracle Data Integrator > Topology Manager

In the Topology Manager select Physical Architectures
>Technologies>Oracle>SRC_CONN_PHYSICAL.

3. Replace the added TNSNAME (Example: AGILE9_LAB1) in the DB link column.

Credential retrieval failure error on ETL run (Agile PLM)

My Database server and ODI/ETL systems are in two different domains. When | run ETL, the
ODI_INT_CREATE_DBLINK scenario returns the following message:

ORA-12638: Credential retrieval failed.

Cause:

The source DB and target DB are in different domains.
Action:

To eliminate the DBLINK errors:
4. Navigate to the $oracle home%\network\admin directory.
5. Modify the SID and HOSTNAME in the TNSNAME entry to reflect the domain name.
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6. Start > Oracle > Oracle Data Integrator > Topology Manager.
In the Topology Manager, select
Physical Architectures >Technologies>Oracle>SRC_CONN_PHYSICAL.
8. Replace the added TNSNAME ( Example: AGILES.ALABO1) in the DB link column.

To verify DBLINK:
Execute the scenario ODI_INT_CREATE_DBLINK from ODI operator in ODI.

If the scenario fails, the following message appears again:
Link AGILE9.ALABOl error: ORA-12638: Credential retrieval failed

To resolve this issue:
1. Navigate to the %oracle_home%\network\admin directory
2. Modify the value of SQLNET.AUTHENTICATION_SERVICES in sqlnet.ora file as follows:
Original Entry - SQLNET.AUTHENTICATION_SERVICES= (NTS)
Modified Entry - SQLNET.AUTHENTICATION_SERVICES= (NONE)
Restart the database instance.
Re-run the scenario ODI_INT_CREATE_DBLINK from ODI operator in ODI.

Unable to run ETL after a configuration change

If there are any PLM configuration changes, such as the renaming of an attribute, it is
recommended that you run a full ETL. Consult Oracle Support if you need help in resetting your
ETL to full load.

Errors when using external .csv files

Do not add deleted Projects to the prj_cost.csv and prj_forecast.csv files.

If any ETL task fails during run-time the best option is to check the Execution tab of the ETL task in ODI Operator:
1. Log into ODI Operator.

Select the Sessions List tab.

Expand All Executions in the left pane.

Select the task that is failing by double-clicking on it.

a b WD

Select the Execution tab to view error details. Optionally, you can also export entire log file as an
XML file thru Operator to check for multiple errors.

6. If the scenario name starts with ODI_PRO, look for PL/SQL errors logged in the VLOG table. See
PL/SQL Logging section for more details on how to enable "debug mode" for detailed PL/SQL
traces. Debug Mode for PL/SQL should be enabled if you need to further debug the issue.
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If any ETL task hangs during run-time, check the Execution tab of the ETL task in ODI Operator:

1.

o > W DN

Log in to ODI Operator.

Select the Sessions List tab.

Expand All Executions in the left pane.

Identify the task that is hanging by double-clicking on it.

Consult your DBA and provide the details noted in the previous step to help research and
possibly identify any long-running SQL in the Data Mart schema.

Enable the Debug Mode for PL/SQL and look for errors in the VLOG table.

PL/SQL Logs

The log details are stored in the following table/view in the Data Mart schema

TLOG (table) This table contains information like timestamp, ID etc. This table will be appended, if the

mode is ERRORMODE. This table will be purged, if the mode is DEBUGMODE

VLOG (view) This is a view created for the TLOG table and contains only the ERROR messages. The

difference between ERROR_MODE and DEBUG_MODE is explained below

ERROR MODE This is the default mode. The value for this is '0' in the DEBUG_MODE column of the

ETL_PARAMETER Table in the Data Mart schema and captures the error message.

DEBUG MODE This mode contains the value '1'in the DEBUG_MODE column of the ETL_PARAMETER

table in the Data Mart schema and captures step-by-step information inside a PL/SQL
Procedure.

Database Issues

Connectivity Errors

o

u]

u]

u]

Agile PLM or Agile PLM for Process source database is available and accessible from the
Oracle PLA Data Mart machine

Verify source database schema details
Target (Oracle PLA Data Mart) database is available

Verify Target database schema details

DB Link does not work when source and target schema are created in the same database (Agile PLM)

Create a TNS name that is different from the database name and SID. In the ODI Topology
Manager, go to Physical Architecture>Technologies>Oracle>SRC_CONN_PHYSICAL. Manually
update the Instance/Data Server field.
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Data Issues such as column width

Check the column in both Source and Target schema (refer to Schema documentation for
table/column details).

Disk space

Check the Target database machine to ensure enough space is available for ETL to execute and
add data.

Database Sessions to execute ETL

Check the database for enough sessions (>500) with which the ODI will run smoothly. To check
database session and process parameters:

1. Login as sys/<PWD> as sysdba in command prompt using sqlplus.
SHOW PARAMETER SESSIONS
SHOW PARAMETER PROCESSES

2. Alter system set processes=1000 scope=spfile; OR

3. Alter system set processes=1000 scope=Dboth;

4. After altering the Database, restart the instance.
Linux/Unix Specific only

o If you receive a 'cannot execute' message, re-run the command with the following options:
chmod u+x PLMBISetup*.bin

o Make sure the TNS Listener is running with the ps —-ef | grep tns command. If nothing
shows, then it is not running.

@ If the TNS Listener is running, check the status with the 1snrctl status command.
Unable to view reports

When | login to the Oracle Product Lifecycle Analytics Application, | am unable to view any report.
The window displays ODBC Driver errors.

Action:

If either TNSNAMES or MDS schema names or both are not default, reconfigure the
TNSNAMES.ORA file, CONNECTION POOL details and MDS Schema Name in OBIEE
Administrator, as appropriate.

Performance degrades on 64-bit platform with Oracle Database 10.2.0.3
Apply Oracle Patch to upgrade database to version 10.2.0.4.

Detecting Errors in ODI coming from Oracle

Errors appear often in Oracle Data Integrator in the following way:

java.sqgl.SQLException: ORA-01017: invalid username/password; logon
denied
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at
at

The java.sql.SQLException code simply indicates that a query was made to the database through the
JDBC driver, which has returned an error. This error is frequently a database or driver error, and
must be interpreted in this direction.

Only the part of text in bold must first be taken in account. It must be searched in the Oracle
documentation. If its contains an error code specific to Oracle, like here (in red), the error can be
immediately identified.

If such an error is identified in the execution log, it is necessary to analyze the SQL code sent to the
database to find the source of the error. The code is displayed in the description tab of the task.

The most common errors with an Oracle server are detailed below, with their principal causes.

Connection Errors

1. UnknownDriverException
The JDBC driver is incorrect. Check the name of the driver.

2. 1/0O Exception: Connection
refused(DESCRIPTION=(TMP=)(VSNNUM=135290880)(ERR=12505)(ERROR_STACK=(ERR
OR=(CODE=12505)(EMFI=4))))

The instance name in the JDBC URL is invalid. Check ODI Topology Manager to make sure
JDBC URL is correct.

3. 1/O Exception: The Network Adapter could not establish the connection
The IP address, machine name of Oracle listener port, is incorrect in the JDBC URL.
4. ORA-01017: invalid username/password; logon denied

The user and/or password specified in the data server definition is invalid. This error may also
appear for certain Oracle Data Integrator commands, such as SqglUnload. This error may also
appear if the source and target DB are different versions.

5. Protocol violation

This error indicates an incompatibility between the Oracle JDBC driver and the database you
connect to. If it occurs at connection time, or at the first operation launched on the Oracle
database, then install the version of the Oracle JDBC driver provided with your database
installation.

6. ORA-00600 internal error code
Internal error of the Oracle database. May be caused by a driver incompatibility.
7. ORA-12154 TNS: could not resolve service name

TNS alias resolution. This problem may occur when using the OCI driver, or a KM using
DBLinks. Check the configuration of the TNS aliases on the machines.

8. ORA-02019 connection description for remote database not found

You are using a KM with non-existing DBLinks. Check the KM options and pre-requisites.
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9.

ORA-02085: database link string connects to string
Set GLOBAL_NAME to FALSE in the database.

Errors in Interfaces

1.

ORA-00900 invalid SQL statement
ORA-00923 FROM Keyword not found where expected.

The code generated by the interface, or typed in a procedure is invalid for Oracle. This is
usually related to an input error in the mapping filter of join. The typical case is a missing quote
or an unclosed bracket.

A frequent cause is also the call made to a non SQL syntax, like the call to an Oracle stored
procedure using the syntax EXECUTE SCHEMA.PACKAGE.PROC(PARAM1, PARAM2).
The valid SQL call for a stored procedure is:

BEGIN

SCHEMA . PACKAGE . PROC (PARAM1, PARAM?2) ;

END;

The syntax EXECUTE SCHEMA.PACKAGE.PROC (PARAM1, PARAM?2) is specific to
SQL*PLUS, and does not work on the Oracle JDBC Thin driver.

ORA-00904 invalid column name

Keying error in a mapping/joinffilter. A string which is not a column name is interpreted as a
column name, or a column name is misspelled.

This error may also appear when accessing an error table associated to a datastore with a
recently modified structure. It is necessary to impact in the error table the modification, or drop
the error tables and let Oracle Data Integrator recreate it in the next execution.

ORA-00903 invalid table name

The table used (source or target) does not exist in the Oracle schema. Check the mapping
logical/physical schema for the context, and check that the table physically exists on the
schema accessed for this context.

ORA-00972 Identifier is too Long

There is a limit in the object identifier in Oracle (usually 30 characters). When going over this
limit, this error appears. A table created during the execution of the interface went over this
limit, and caused this error (see the execution log for more details).

Check in the topology for the oracle technology, that the maximum lengths for the object names
(tables and columns) correspond to your Oracle configuration.

ORA-01790 expression must have same datatype as corresponding expression

You are trying to connect two different values that can not be implicitly converted (in a
mapping, a join). Use the explicit conversion functions on these values.
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Purging Logs

Use Purge Log feature which is available in ODI Operator:
1. Login to ODI Operator.
2. Go to File | Purge Logs option
Note  Users have option to Purge Logs based on Timeline (From/To Date), Context,
Agent, Status, User Name and Session hame.

In purging Agile PLM Data Mart logs, it is up to you on how you want to implement it. Refer to the
ODI documentation for more details.

Archiving

It is recommended to take regular backups of the following:

= Data Mart Target DB schema

o VLOG (Parameter table)

o ODl logs (this can be done by using the "Export Logs" feature in ODI Operator).
To use Export Logs:

1. Login to ODI Operator

2. Select to "Export Logs" option from "File" drop down list

Changing the Database Password

To update the connection details for Source or Target database, update the
DataMartconfig.properties file in <Agile PLM Data Mart Home directory>/config folder.
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Note  Before updating, encrypt the password using the dmencoder utility, located in the bin
directory of the Agile PLM Data Mart install folder.

The following sections must be updated because of the password change:

o PLM Source DB Details : # PLM DATABASE DETAILS ###

o Target Data Mart DB Details: ####### DataMart Database Details######

o Target Data Mart DB Schema Details: ###PLM Database TNSEntry Name####

o ODI Database Schema Details: ## Oracle Data Integrator Repository Details##ODI Work
Repository Details: # ODI Work Repository Details

Improving ETL Performance

It is recommended to increase the Heap-Size to enhance ETL performance. This can be done in the
startdmparams.bat file located in <ODI Home> / bin directory

The default setting in the startdmparams.bat file is

set ODI_INIT HEAP=32m
set ODI_MAX HEAP=256m --- this gets mapped into -Xmx%0ODI MAX HEAP%

Note  For Linux Machines set ODI_MAX_HEAP=1024m

Deployment

1. Schema Configuration

The source PLM Database schema and Target Database schema MUST be 30 characters or
less. Also, it may not contain any special characters except underscore " "

2. Install Location Restrictions

Agile PLM PLM Data Mart should not be installed in a directory which contains operating
systems files (e.g. c:\)

Agile PLM Data Mart should not be installed in any directory which has space in it (e.qg.
d:\program files).

The ODI home directory should not exist in a directory which has space it. If it does, the Agile
PLM Data Mart installation will not proceed.

3. Table space Data Sizing

Refer to the Agile PLM Business Intelligence Capacity Planning Guide for complete
information.
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The Implementation of the Agile PLM BI application in Development, Test and Production
environments require distinct Data Mart Installations on these environments.

The Installer creates both Master and Work Repositories, by default. This installation is used in the
Development environment. The Production and Test environments use separate work repositories
on top of the existing Master Repository.

Pre-installation Notes

The following pre-installation guidelines require you to ensure that:

o The Master Repository exists, if you want to configure work repositories in Test or Production
environments.

o The existing Master Repository ID is specified in the DataMartConfig.properties file.

= All the required Database users such as Data Mart Schema user and Work Repository Schema
user are created before you run the batch file, DMOnEXxistingMasterRep.

= All the Logical connections related to Data Mart are present in the existing Master repository.

o You use the Installer.exe file to create Master repository, Work Repository and all of the Data
Mart related ETL components.

o The Repository ID is within the range of 100-999. Do not use numbers such as
100,101,102,103.555,666 that are already used in the product development environment. For
more information, refer to the ODI Documentation.

o The DataMartConfig.properties file is configured before you run the batch file,
DMOnExistingMasterRep.

The following are the steps to create a new work repository and Data Mart ETL components on an
existing master repository:

1. Create schema and work repositories

2. Install ETL components

Creating Schema and Work Repositories

Generate scripts for the Work Repository and Data Mart schema using the 'Generate SQL Script'
option of the Data Mart installer.
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To create the Data Mart schema:
1. Navigate to the location where you have installed the scripts. Example: D:\schema
2. Open the file UsersCreation.sql. This file contains all of the database user creation statements.

3. Run the user creation statements in the database where the Data Mart and Work Repository
schema must be created.

4. Runthe ODM.sql file.

Installing ETL Components

The following are the steps that enable you to install the ETL Components:
Extract the Data Mart files.

Copy the JDK files.

Configure property files or batch files.

Execute Batch or Shell file.

Configure Physical Connection in the Topology Manager.

2 T o

Export the Work Repository and Import into the QA or Production environment.

Extract the Data Mart files

Use WinZip to extract the DM 3.2.0.2.zip files to the Data Mart 3.2.0.2 folder.
Example: D:\DM3.2.0.2

The location shows the following sub folders:

= Ant

o Bin

@ Config
o Install
o Lib

o Logs

Copy the JDK files

Copy the JDK folder provided as part of DM3.2.0.2.zip file to the DM3.2.0.2 folder.
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Configure property files or batch files

The following are the property files that need configuration changes:

o DataMartConfig.properties

o Temp.properties

= DMOnExistingMasterRep.bat or .sh

DataMartConfig.properties: Example Location: D:\DM3.2.0.2\config\DataMartConfig.properties

The following table lists all the properties in the DataMartConfig.properties file for Windows:

DataMartConfig.properties

Windows
Property Name Token Example
AA_HOME <INSTALL_DIR> D:\\DM3.2.0.2
ODI_HOME <ODI_HOME> E:\\OracleDI\\oracledi
REPOSITORY_OPTION DEFAULT QA
Note If you want to create the Master

Repository, Work Repository and

import all Data Mart ETL

components using manual scripts,

do not modify this token.
PLM_DATABASE <SRC_SID_T> AGILE
PLM_DB_HOST <EXIST_SRDB_HOST_T> agilelab1
PLM_DB_PORT <EXIST_SRDB_PORT_T> 1521
PLM_DB_USER <SRC_USER_T> SAMP9226
TGT_DB_SID <TGT_DBNAME_T> DM32
TGT_DB_HOST <TGT_HOST_NAME_T> AGILELAB2
TGT_DB_PORT <TGT_DB_PORT> 1521
ODM_USERNAME <TGT_USER_T> ODM2
MASTER_UN <ODI_MASTER_UN> ODIMASTER1
WORK_UN <TGT_WORK_SCHEMA_NAME> ODIWORK2
WORK_REP_NAME <ODI_WORKREP> WORKREP2
WORK_REP_ID <WORK_REP_ID> 123
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MASTER_REP_ID <MASTER_REP_ID> 124

PQM <PQM_T> Y

PPM <PPM_T> Y

PC <PC_T> Y

PCM <PCM_T> Y

PGC <PGC_T> Y

NOTIFICATION_EMAILID <TO_EMAIL_T> DATAMART@ORACLE.COM

MAILSERVER <EXCH_SERVER_T> MAIL.ORACLE.COM

SOURCE_DB_URL jdbc:oracle:thin:@ jdbc:oracle:thin:@
<EXIST_SRDB_HOST_T>: agilelab1:
<EXIST_SRDB_PORT_T>: 1521:
<SRC_SID_T> agile

TGT_DB_URL jdbc:oracle:thin:@ jdbc:oracle:thin:@
<TGT_HOST_NAME_T>: agilelab1:
<TGT_DB_PORT>: 1521:
<TGT_DBNAME_T> DM32

MASTER_DB_URL jdbc:oracle:thin:@ jdbc:oracle:thin:@
<TGT_HOST_NAME_T>: agilelab1:
<TGT_DB_PORT>: 1521:
<TGT_DBNAME_T> DM32

WORK_DB_URL jdbc:oracle:thin:@ jdbc:oracle:thin:@
<TGT_HOST_NAME_T>: agilelab1:
<TGT_DB_PORT>: 1521:
<TGT_DBNAME_T> DM32

The following table lists all the properties in the DataMartConfig.properties file for Linux:

DataMartConfig.properties

Linux or Solaris

Property Name Token Example
AA_HOME <INSTALL_DIR> /home/oracle/DM3.2.0.2
ODI_HOME <ODI_HOME> /home/oracle/odi
REPOSITORY_OPTION DEFAULT PRODUCTION
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PLM_DATABASE <SRC_SID_T> AGILE
PLM_DB_HOST <EXIST_SRDB_HOST_T> agilelab8
PLM_DB_PORT <EXIST_SRDB_PORT_T> 1521
PLM_DB_USER <SRC_USER_T> SAMP93
TGT_DB_SID <TGT_DBNAME_T> DM32
TGT_DB_HOST <TGT_HOST_NAME_T> AGILELAB4
TGT_DB_PORT <TGT_DB_PORT> 1521
ODM_USERNAME <TGT_USER_T> ODM3
MASTER_UN <ODI_MASTER_UN> ODIMASTER1
WORK_UN <TGT_WORK_SCHEMA_NAME> ODIWORK3
WORK_REP_NAME <ODI_WORKREP> WORKREP3
WORK_REP_ID <WORK_REP_ID> 125
MASTER_REP_ID <MASTER_REP_ID> 124
PQM <PQM_T> Y
PPM <PPM_T> Y
PC <PC_T> Y
PCM <PCM_T> Y
PGC <PGC_T> Y
NOTIFICATION_EMAILID <TO_EMAIL_T> DATAMART@ORACLE.COM
MAILSERVER <EXCH_SERVER_T> MAIL.ORACLE.COM
SOURCE_DB_URL jdbc:oracle:thin:@ jdbc:oracle:thin:@
<EXIST_SRDB_HOST_T>: agilelab1:
<EXIST_SRDB_PORT_T>: 1521:
<SRC_SID_T> agile
TGT_DB_URL jdbc:oracle:thin:@ jdbc:oracle:thin:@
<TGT_HOST_NAME_T>: agilelab1:
<TGT_DB_PORT>: 1521:
<TGT_DBNAME_T> DM32
MASTER_DB_URL jdbc:oracle:thin:@ jdbc:oracle:thin:@
<TGT_HOST_NAME_T>: agilelab1:
<TGT_DB_PORT>: 1521:
<TGT_DBNAME_T> DM32
WORK_DB_URL jdbc:oracle:thin:@ jdbc:oracle:thin:@
<TGT_HOST_NAME_T>: agilelab1:
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<TGT_DB_PORT>:
<TGT_DBNAME_T>

1521:
DM32

Temp.properties: Example Location D:\DM3.2.0.2\config\Temp.properties

The following table lists all the properties in the Temp.properties file:

Temp.properties
Property Name Token Example

PLM_DB_PWD_HIDE <SRC_USER_PWD_T> AGILE
ODM_USER_PASSWORD_HIDE <TGT_USER_PWD_T> ObDM
MASTER_PWD_HIDE <ODI_MASTER_PWD> ODIMASTER
WORK_PWD_HIDE <ODIWK_DBPWD> ODIWORK
TGT_SYS_USER_PWD_HIDE <TGT_SYS_PWD> ORACLE
TGT_SYSTEM_USER_PWD_HIDE <TGT_SYSTEM_PWD> MANAGER
WORK_REP_ODI_PWD <WORK_REP_ODI_PWD> WORKREP

DMOnExistingMasterRep.bat or .sh

The following table lists all the properties in the DMOnEXistingMasterRep.bat or .sh file:

DMOnExistingMasterRep.bat or sh

Windows
Property Name Token Example
<INSTALL_DIR> <INSTALL_DIR> D:\DM3.2.0.2

DMOnExistingMasterRep.bat or sh

Linux or Solaris

Property Name Token

Example

<INSTALL_DIR> <INSTALL_DIR>

/home/oracle/DM3.2.0.2
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Execute Batch or Shell file

To execute a batch or shell file:

1. Inthe command prompt or terminal window, navigate to the bin directory of the Data Mart
3.2.0.2 Installation folder. Example: D:\DataMart3.2.0.2\bin

2. Run the DMOnEXxistingMasterRep.bat or DMOnEXxistingMasterRep.sh file

Important Check the logs folder for error logs. Example: D:\DataMart3.2.0.2\logs

If you want to create the Master Repository, Work Repository and import all Data Mart ETL
components using manual scripts, run the DataMartTLInstall.bat or DataMartETLInstall.sh file.

Before you run the batch file ensure that:
@ All the required schemas exist.

o The config.properties file and DataMartTLInstall.bat or DataMartETLInstall.sh are configured as
described in the Configure the config or batch files section.The tokens for DataMartTLInstall.bat
or DataMartETLInstall.sh are same as DMOnEXxistingMasterRep.bat or .sh.

Configure Physical Connection in the Topology
Manager

In the Context tab of the Topology Manager, configure the Physical Connection in the Schemas tab.

For the Test Context:

Context Name SRC or Logical Schema Physical Schemas
Target
PLMDM_QA Source SRC_CONN_LOGICAL SRC_QA_CONN_PHYSICAL.<SRC_SCH_NAME>
Target TRG_ODMCONN_LOGICAL TRG_ODM_QA_CONN_PHYSICAL.<TRG_SCH_N
AME>

For the Production Context:

Context Name SRC or Logical Schema Physical Schemas
Target
PLMDM_PRODUCTION Source | SRC_CONN_LOGICAL SRC_PROD_CONN_PHYSICAL.<SRC_SCH_NAME>
Target TRG_ODMCONN_LOGICAL TRG_ODM_PROD_CONN_PHYSICAL.<TRG_SCH_NA
ME>
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Export the Work Repository and Import into the
QA or Production environment

Export the Work repository from the Development environment and Import it into the Test or
Production environment based on your configuration.

To export the Work Repository:

o 0k w

Login to ODI Designer using Development Work Repository credentials.
Click File > Export >Work Repository.

Select the Export to Zip file option.

Choose a directory into which you wan to export the repository.

Enter a name for the repository.

Click OK.

To import the Development Work Repository in Test or Production work repository:

o g A~ w DN kE

Login to ODI Designer using Production or Test Work Repository credentials.

Click File > Import > Work Repository.

Select Synonym Mode INSERT_UPDATE from the drop down list.

Select the Import from a zip file option.

Choose the directory that has the zip file exported from the Development environment.
Click OK.

Note If you wish to change your PLM (source) schema details, refer to the Knowledge Base

on Oracle Support for detailed instructions. You need to sign in to Oracle Support to view
the content.
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Manually Installing Agile PLM Data Mart
ETL

This Appendix includes the following:

# Pre-InStallation NOES ........coiiiiiieicrc e 57
B CreatiNG SCREMAS ......vuivieiiie s 57
B INSEAIING ETL e 58

This appendix describes the process to manually install Agile PLM Data Mart ETL.

Pre-Installation Notes

Before starting the installing, make sure the following guidelines apply:

= All of the required database users, like the Data Mart schema and Work Repository users,
should be created before running the install script.

o The Repository ID should be within the range of 100-999.

o Do not use the following numbers because they are already in use:
100-103, 555, 666

Refer to the ODI documentation found on the Oracle Technology Network (OTN) Web site
http://www.oracle.com/technology/documentation for more information.

o Configure the properties file before running the install script.

Creating Schemas

During the Agile PLM Data Mart installation, select the Generate SQL Scripts option to generate the
scripts for the work repository and Agile PLM Data Mart schema.

Note Ignore this step if the schemas are created during the Agile PLM Data Mart installation.

To create the schemas:

1. After the scripts are generated in the installation location, open the UsersCreation.sql script in the
schema directory.

2. Run the UsersCreation.sqgl script on the database where the Agile PLM Data Mart, Master
Repository, and Work Repository schemas are to be created.

3.  Run the ODM.sql script.
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Installing ETL

To install the ETL, perform the following steps:
1. Unzip the DM3.2.0.2.zip files to the DM3202 folder.
2. Inthe DM3.2.0.2/JRE folder, unzip the jre.zip file.

3. Copy the operating system specific JDK folder to the DM3.2.0.2 folder. If the JDK folder is not
found, copy the JDK folder from your machine to the DM3.2.0.2 folder.

4. Rename the JDK folder, as follows:

Linux and Solaris: Rename the jdk_linux_solaris folder to jdk.
AIX: Rename the jdk_aix folder to jdk.

Windows: Rename the jdk_windows folder to jdk.

Note

Be sure to execute permission to all folders and files on UNIX operating systems.

5. Configure the following properties files, located in the config directory:

a. DataMartConfig.properties

DataMartConfig.properties
Windows
Property Name Token Example
AA_HOME <INSTALL_DIR> D:\DM3.2.0.2
ODI_HOME <ODI_HOME> E:\\OracleDI\\oracledi
REPOSITORY_OPTION | DEFAULT DEFAULT
PLM_DATABASE <SRC_SID_T> AGILE
PLM_DB_HOST <EXIST_SRDB_HOST_T> agilelab1
PLM_DB_PORT <EXIST_SRDB_PORT_T> 1521
PLM_DB_USER <SRC_USER_T> SAMP9226
TGT_DB_SID <TGT_DBNAME_T> DM32
TGT_DB_HOST <TGT_HOST_NAME_T> AGILELAB2
TGT_DB_PORT <TGT_DB_PORT> 1521
ODM_USERNAME <TGT_USER_T> ODM2
MASTER_UN <ODI_MASTER_UN> ODIMASTER1
WORK_UN <TGT_WORK_SCHEMA_NAME> ODIWORK2
WORK_REP_NAME <ODI_WORKREP> WORKREP2
WORK_REP_ID <WORK_REP_ID> 123
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MASTER_REP_ID <MASTER_REP_ID> 124

PQM <PQM_T> Y

PPM <PPM_T> Y

PC <PC_T> Y

PCM <PCM_T> Y

PGC <PGC_T> Y

NOTIFICATION_EMAILID <TO_EMAIL_T> DATAMART@ORACLE.COM

MAILSERVER <EXCH_SERVER_T> MAIL.ORACLE.COM

SOURCE_DB_URL jdbc:oracle:thin:@ jdbc:oracle:thin:@
<EXIST_SRDB_HOST_T>: agilelab1:
<EXIST_SRDB_PORT_T>: 1521:
<SRC_SID_T> agile

TGT_DB_URL jdbc:oracle:thin:@ jdbc:oracle:thin:@
<TGT_HOST_NAME_T>: agilelab1:
<TGT_DB_PORT>: 1521:
<TGT_DBNAME_T> DM32

MASTER_DB_URL jdbc:oracle:thin:@ jdbc:oracle:thin:@
<TGT_HOST_NAME_T>: agilelab1:
<TGT_DB_PORT>: 1521:
<TGT_DBNAME_T> DM32

WORK_DB_URL jdbc:oracle:thin:@ jdbc:oracle:thin:@
<TGT_HOST_NAME_T>: agilelab1:
<TGT_DB_PORT>: 1521:
<TGT_DBNAME_T> DM32

The following table lists all the properties in the DataMartConfig.properties file for UNIX:

DataMartConfig.properties

UNIX
Property Name Token Example
AA_HOME <INSTALL_DIR> /home/oracle/DM3.2.0.2
ODI_HOME <ODI_HOME> home/oracle/odi
REPOSITORY_OPTION DEFAULT DEFAULT
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PLM_DATABASE <SRC_SID_T> AGILE
PLM_DB_HOST <EXIST_SRDB_HOST_T> agilelab8
PLM_DB_PORT <EXIST_SRDB_PORT_T> 1521
PLM_DB_USER <SRC_USER_T> SAMP93
TGT_DB_SID <TGT_DBNAME_T> DM32
TGT_DB_HOST <TGT_HOST_NAME_T> AGILELAB4
TGT_DB_PORT <TGT_DB_PORT> 1521
ODM_USERNAME <TGT_USER_T> ODM3
MASTER_UN <ODI_MASTER_UN> ODIMASTER1
WORK_UN <TGT_WORK_SCHEMA_NAME> ODIWORK3
WORK_REP_NAME <ODI_WORKREP> WORKREP3
WORK_REP_ID <WORK_REP_ID> 125
MASTER_REP_ID <MASTER_REP_ID> 124
PQM <PQM_T> Y
PPM <PPM_T> Y
PC <PC_T> Y
NOTIFICATION_EMAILID <TO_EMAIL_T> DATAMART@ORACLE.COM
MAILSERVER <EXCH_SERVER_T> MAIL.ORACLE.COM
SOURCE_DB_URL jdbc:oracle:thin:@ jdbc:oracle:thin:@
<EXIST_SRDB_HOST_T>: agilelab1:
<EXIST_SRDB_PORT_T>: 1521:
<SRC_SID_T> agile
TGT_DB_URL jdbc:oracle:thin:@ jdbc:oracle:thin:@
<TGT_HOST_NAME_T>: agilelab1:
<TGT_DB_PORT>: 1521:
<TGT_DBNAME_T> Dm32
MASTER_DB_URL jdbc:oracle:thin:@ jdbc:oracle:thin:@
<TGT_HOST_NAME_T>: agilelab1:
<TGT_DB_PORT>: 1521:
<TGT_DBNAME_T> DM32
WORK_DB_URL jdbc:oracle:thin:@ jdbc:oracle:thin:@
<TGT_HOST_NAME_T>: agilelab1:
<TGT_DB_PORT>: 1521:
<TGT_DBNAME_T> DM32
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b. Temp.properties:

Temp.properties
Property Name Token Example

PLM_DB_PWD_HIDE <SRC_USER_PWD_T> AGILE
ODM_USER_PASSWORD_HIDE <TGT_USER_PWD_T> ODM
MASTER_PWD_HIDE <ODI_MASTER_PWD> ODIMASTER
WORK_PWD_HIDE <ODIWK_DBPWD> ODIWORK
TGT_SYS_USER_PWD_HIDE <TGT_SYS_PWD> ORACLE
TGT_SYSTEM_USER_PWD_HIDE <TGT_SYSTEM_PWD> MANAGER
WORK_REP_ODI_PWD <WORK_REP_ODI_PWD> WORKREP

6. Configure the <INSTALL_DIR> property in the DataMartETLInstall script file, located in the bin

directory.
7. Run the DataMartETLInstall script.

Note If the Java heap size needs to change, modify the ODI_MAX_HEAP parameter in
the startdmparams script file, located in the <ODI_HOME>\bin directory.

8. Check the logs directory for error logs.
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